
WP 6.x Changes & Enhancements Manual

This file was assembled by Richard Wood to bring together in a single file a summary of the
differences between all versions of WordPerfect 6.x for DOS, and instructions on using many
of these changes.  It includes information on all changes through WordPerfect 6.2
additions/enhancements.  The following list has been arranged in alphabetical order and
specifies which version of WP 6.x introduced the given change/enhancement.  A function
index appears at the end.  It may help WP 6.0a, WP6.0b, WP 6.0c, WP 6.1 and WP 6.2 users
who do not have access to a manual that includes the changes information.  All copies of WP
6.0x seem to have come with the original manual only from version 6.0.  Information on
additions and changes has only been available from the HELP screens.  My Novell CD version
of 6.1 included an Infobase version of the changes manual which included all changes up to
version 6.1.  No manuals were on my CD only copy of Corel WP 6.1 but very complete
manual files for WP 6.2 were on the CD bought from Carol Reese, “ The WP Lady”,
including extensive manuals on the WP 6.x Macro language.

BLOCK OPERATIONS WP 6.2

Option to make typing replace blocked text (as in Windows version)

Option to leave block on after block operations (allows additional block formatting or typing)

You can now select options under Setup: Environment to leave Block on after you finish
formatting selected text and to replace text as you type (instead of increasing the size of the
block).  See Leave Block On After Block Operation and Typing Replaces Blocked Text
under “ Block...”.

BUTTON BARS WP 6.0b

Adding a button to a Button Bar would always place the newly added button at the bottom of
the list in prior WP 6.x versions.  Buttons are now inserted at the highlight bar in the list of
buttons.

COACHES WP 6.0b

The Coaches list is now sorted by document descriptive name rather than by filename.

COACHES WP 6.1
 
Handy WordPerfect Coaches are ready to introduce you to the basics of using each new
feature.  You can have the Coach guide your selections or make selections for you as you
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watch.  Many other new Coaches are also available to help you explore the various features. 
Coaches were introduced in WP 6.0 but have been greatly enhanced in WP 6.1.  WP 6.0c had
10 coaches available while WP 6.1 and WP 6.2 have 33.  Note that in Graphics mode Coaches
will only run in a 640 x 480 VGA graphics screen environment.  Any higher resolution screen
setup causes an error message and the Coach cannot be run.  See Coaches.  
CONVERT GRAPHICS WP 6.0b
 
You can now save the first bitmapped image contained in a WPG 2.0 file from the image
editor in any of the following formats: TIFF, TrueVision, TARGA and Paintbrush PCX.

CUT/PASTE WP 6.2

Smart selection for cutting and pasting (removes extra spaces).  This is a transparent change
that requires no user action to utilize.

DISPLAY SETUP WP 6.0a

In Graphics mode, you can now change the colors of the dialog block background and text,
mouse pointer fill and border, and document background and foreground.  See Graphics
Screen Colors.   Choose File, Setup, Display, 1, 2 to access.

Create or Edit Graphics Screen Colors (Setup)

Shift+ F1, Display, Graphics Mode Screen Type/Colors, Color Schemes, Create or Edit
        
Purpose: You can edit an existing color scheme, or create a new one.  You cannot edit a

WordPerfect predefined color scheme.
Steps:

1  Choose Setup from the File menu, then choose Display.

2  Choose Graphics Mode Screen Type/Colors.

3  Choose Color Schemes.

4  To create a color scheme, choose Create, type a name for your color scheme, then
choose OK;  or...  To edit an existing color scheme, choose Edit.

5  Choose Screen Elements, then select an element.

6  Choose Color, then select a color for that element.

7  Continue selecting as many elements and colors for those elements as you want.
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8  Choose OK.

DROP CAPS WP 6.1

Drop caps are distinctively designed letters that decorate text at the beginning of a line or
paragraph.  WordPerfect 6.1 for DOS quickly creates drop caps for you and gives you
extensive capabilities for customizing them.  

Drop Cap, Creating:

        <   Font, Drop Cap
        <   Shift+ F8, Character, Drop Cap
        <   Layout, Character, Drop Cap

Purpose: Drop caps are distinctively designed letters that decorate text at the beginning of
a line or paragraph.

Steps:

1  Place the cursor at the beginning of a blank line or.. .  Place the cursor in a paragraph.

2  Choose Drop Cap from the Font menu.

3  Choose In Text to insert the drop cap within the paragraph or.. .  Choose In Margin to
insert the drop cap fully in the left margin.

You are returned to your document.  

If you have not yet typed text, the first letter you type will become a drop cap.  Otherwise, the
first letter of the current paragraph becomes a drop cap.

See Also in Help:

Drop Cap Appearance and Placement
Drop Cap, Deleting
Drop Cap, Repeating

DUPLICATE CODES WP 6.1

WordPerfect doesn' t by default insert unnecessary duplicate codes.  For example, if you are in
Times Roman 12 point font, and you reset the font to Times Roman 12 point,  WordPerfect
does not insert a new font code.  You now have the option of having WordPerfect insert codes
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whenever you use a feature, even when the new codes duplicate existing conditions.  Access
from File, Setup, Environment.  See Allow Duplicate Codes or Duplicate Codes.

ENVELOPES WP 6.0a

The bar code position can now be changed to above or below the mailing address.  See Bar
Code Position.  This may be listed as a separate heading in the “ Bar Code” Help screen. 

Bar Code Position: Shift+ F8, Page, Envelope, Shift+ F1, Bar Code Position
        
Purpose: Use Bar Code Position to specify whether the bar code should appear above or

below the mailing address.

Steps:

1  Choose Envelope from the Layout menu, then choose Setup.

2  Choose Bar Code Position, then choose a position.

FAX WP 6.0a

You can delete entries from the Send and Receive Logs.  See Send Log and Receive Log.

Fax Setup has been added so you can change the default fax resolution, add a coversheet, or let
WordPerfect delete the fax file when the file is sent.  See Fax Setup.

FAX WP 6.0b

Using FaxDirect, you can include up to 100 fax files with Fax On Disk (Shift+ F7,x,s,a).
Previously, you could only include one file. The WordPerfect CAS Setup program will now
auto-detect the COM port and class driver of the fax modem.  If the configuration file does not
exist,  then the auto-detection will occur automatically when entering SETUP.EXE.  Otherwise,
the user may press 2 for Hardware Driver Setup and then press F4.

When pressing F10 from within the Hardware Driver Setup, the program will check the
settings to make sure they are valid.  This auto-detection also works for user-specified
non-standard interrupts.

You can now use two methods to customize fax coversheets.  Please refer to README.FAX
for details on creating custom coversheets.

FAX DIAL-OUT WP 6.0c
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You can now set up customized fax dialing settings such as area codes, prefix numbers, and
suffix numbers.  You can also turn off call waiting while sending a fax.  See Fax Dial-Out
Instructions.

FILE MANAGER WP 6.0a

You can use find conditions for a specific date or range of dates.  See QuickFinder Search in
Help and see QuickFinder below in this document.

FILE MANAGER WP 6.0b

Option 9 in File Manager is now "Create Dir," which allows users to create a new directory
from within WordPerfect.

The File Manager Sort options are now temporary by default.   You can choose to save them
permanently by choosing "Save Default to Setup File"  (F5,Enter,Sort/Setup).

If you are using descriptive names and types, a file (WP{WPC}.DNS) will be created that will
store the names and types information.  If  you use this file, WordPerfect will display the
names and types faster.  See Use Desc. Name Speedup File.

FIND/QUICKFINDER WP 6.0b

File Manager' s Find feature has been combined with QuickFinder searching to make it more
powerful.   QuickFinder can now search indexes or directories by file date and filename
pattern.  See QuickFinder Search.  QuickFinder has more operators, like case sensitivity and
closeness of words.  See QuickFinder Operators.

FONTS WP 6.0b

Type 1 fonts have been added to the Additional Fonts disk to support the Hebrew, Cyrillic,
Japanese, Arabic, and Arabic Script character sets.

GRAPHICS BOXES WP 6.0a

You can now select overlapping graphics boxes or lines by clicking on the box or line using
the right mouse button.

Allow Box to Overlap Other Boxes (Graphics Boxes)

Alt+ F9, Graphics Boxes, Create or Edit,  Attach To, Paragraph, Edit Position, Allow Box to
Overlap Other Boxes
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Purpose

Use this option to allow a paragraph attached graphics box to overlap other paragraph or page
attached graphics boxes on the page. Note that when you drag a paragraph attached graphics
box, this option is automatically selected.

Steps:

1  Create a graphics box or.. .  Select a graphics box to edit.

2  Make sure Paragraph is selected from the Attach To pop-up list.

3  Choose Edit Position.

4  Select Allow Box to Overlap Other Boxes.

5  Choose OK.

GRAPHICS BOXES WP 6.1

When you insert a new graphics box, it will now remain exactly where you place it on the page
until you move it.   Graphics boxes are now attached to the page, by default, rather to a
paragraph as was previously the case.  In addition, “ Allow Box to Move Page to Page With
Text” is now unchecked.  Consequently, page-attached graphics boxes stay on a page, while
the text you add to a document flows around them.  For information on changing graphics box
attachments, see Edit Position.   This is shown in Help under “ Edit.. .”.

GRAPHICS PRINTING WP 6.0b

The speed for printing bitmapped graphics, as well as printing graphics on most
non-PostScript/non-HPGL printers, has been improved.  This is a user transparent change.

HEADERS, FOOTERS, ENDNOTES, AND FOOTNOTES WP 6.0a
 
You can now edit headers, footers, endnotes, and footnotes in Page Mode by double-clicking
on them.  A right mouse click will bring up options such as Edit,  Delete, Off, or Choose
Object.  See Header/Footer/Watermark Placement or under “ Edit.. .” see the appropriate
entry.

Edit Header/Footer/Watermark

Shift+ F8, Header/Footer/Watermark, Headers, Header A or B
Shift+ F8, Header/Footer/Watermark, Watermarks, Watermark A or B
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Shift+ F8, Header/Footer/Watermark, Footers, Footer A or B
        
Purpose: Use this feature to specify the placement of a header, footer, or watermark and

to edit it.

Steps: To determine the placement,

1  Choose Header/Footer/Watermark from the Layout menu.

2  Choose a Header or Footer or Watermark type (A or B).

3  Select the pages where you want the header, footer, or watermark to appear.

If you want to turn a header, footer, or watermark off for the rest of the document,
choose Off.  You can also block a section first.

To edit a header, footer, or watermark:

1  Choose Header/Footer/Watermark from the Layout menu.  If you are in Page Mode,
you can also double-click on a header, footer, endnote or footnote.  A right mouse click
will bring up options such as Edit,  Delete, Off, or Choose Object.

2   Choose a Header or Footer or Watermark type (A or B).

3  Choose Edit,  then make any changes.

4  Press F7.

HELP WP 6.0a

You can now print a Help topic by pressing Shift+ F7 when displaying that Help topic.  See
Using Help.   By selecting the Ascii Text Printer as default printer and then selecting “ Print to
File” in the I/O port setup, with a default full path and file name entered, the output of printing
a Help topic can be saved as an Ascii text file that then can be imported into WordPerfect for
reformatting and editing prior to final printing.  Do NOT check the “ Prompt for file name”
box during setup for this as the prompt will not work within the Help function.

HISTORIES WP 6.1

If you often edit the same document time after time, a new feature makes it easy for you to do
this.   When you open a document, you can list the last ten documents you have edited, and
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then select the one you want.  History lists are available virtually anywhere you might   want
to use an existing file.  In File Manager, for example, it allows easy access to up to the last 10
directories accessed to import or work with files.  See Histories.   Histories were introduced in
WP 6.0  for a few functions but are extended in 6.1 to many more functions such as Merge,
Sort,  Graphics, File Manager & Envelope.  Also see “ Retrieve” below for a discussion of an
earlier enhancement in this area.

INSTALL WP 6.0a

During install,  WordPerfect will check for the available disk space on the specified drive.  If
the amount of disk space available is less than 2meg compared to the amount determined by the
files marked, then a prompt will state that the successful completion may be determined by
how many printer, graphics cards, and sound drivers selections are made.

When installing Shell 4.0, you can now select whether the Shell directory will be included in
the PATH and if the AUTOEXEC.BAT will be modified to start Shell automatically.

INSTALLATION WP 6.0b

Even though you may choose Never Prompt for Smart Prompting, the Installation program will
prompt to update or replace the WP.DRS if fonts have been added.

If Shell is the last line in the AUTOEXEC.BAT file, installing the FaxDirect files will add the
FAXDIR.EXE and FAXB.COM lines to the AUTOEXEC.BAT before the SHELL line instead
of afterwards.

A new prompt has been added to the Installation program to allow the user to select how to
update a modified speller file, WPUS.LEX.  

The options are:

Replace current Speller file.  This option will replace the current Speller file and the
user will need to make all modifications manually.

Install new file/Rename current file.  This option will rename the existing WPUS.LEX
to WPOLDUS.LEX.  This allows you to chain the two speller files inside of
WordPerfect so that the added words will not be caught.  Because of a version
difference, you will need to run SPELL.EXE dated 2/14/94 in order to convert the file
to the newer format.

MACROS WP 6.0a

Two new system variables have been added, ?PageHeight and ?PageWidth. 
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The SortUndo token has been added.  SortUndo changes the state of Allow Undo.  See Sort.  
The Sort token has an optional parameter that determines whether that sort action will be
undoable.  When the parameter is absent, the current state of Allow Undo determines whether
that sort will be undoable.

MACROS WP 6.0b

CALENDAR.WPM macro has been added that will create portrait/landscape calendars for a
user defined year.  It can be accessed by Ctrl+ k or playing CALENDAR.WPM.

Four new macro system commands have been added:

     ?Ruler
     ?HorizontalScrollBar
     ?VerticalScrollBar
     ?Framed

Twenty-five new macro tokens were added to correspond with new features and enhancements:

     BarcodeDlg
     FaxRasterizeCover
     FileManagerUseSpeedupFile
     FileMangerSaveSetup
     InsertFilenameDlg
     LabelsDlg
     LineNumberingDlg
     PageNumberingDlg
     PageSuppressDlg
     PaperSizeTypeDlg
     PrinterFunctionsDlg
     QuickFinderDefaultDocSummary
     QuickFinderDocSummary
     QuickFinderSearchIn
     QuickFinderResultsLevels
     QuickFinderWPDocsOnly
     RulerNewTabType
     RulerSetup
     SubdividePageDlg
     TableAdjustBegin
     TableAdjustColumnWidth
     TableAdjustEnd
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     TableAdjustPosition
     TableDataFill

MACRO COMMANDS WP 6.1

Several new macro commands have been added to WordPerfect 6.1 representing functions
made available with new and existing features.  See Macros in online Help.

MACRO CONVERSION WP 6.0b

Macro Conversion program now supports the conversion of fractional measurement entries
such as 2 1/4".

MAKE IT FIT WP 6.1

When a resume, term paper, or newsletter must be a certain number of pages, Make It Fit
takes over the work of stretching or squeezing.  Make It Fit expands or shrinks your document
to fit the number of pages you want it to.  See Make It Fit.

Make It Fit: Shift+ F8, Make It Fit

Purpose: You can have WordPerfect make a document fit a certain number of pages.  For
example, Make It Fit will expand or shrink the resume you are creating to fill
just one page.

You specify the number of pages you want and indicate what items to change,
such as margins, line spacing, and font size.  WordPerfect does the rest.

Steps:

1  Choose Make It Fit from the Layout menu.

2  In the Desired Number of Filled Pages box, type the number of pages you want this
document to be.

The number you type must be within 50 percent of the document' s current size.

3  Check the items you want WordPerfect to adjust.

4  Choose Make It Fit.

MERGE WP 6.0a
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An envelope button has been added to the merge dialog box.  See Run Merge.

OPEN AS COPY WP 6.1

You can use a document you have written to create a new one, without having to worry about
deleting or changing the original.  In File Manager files lists press Shift +  F10 to see and be
able to select this option.  See Open as Copy.

Open as Copy : Shift+ F10, Open as Copy

Purpose:
You can use a document you have already made as a model for creating a new one, without
having to worry about deleting or changing the original.

Steps:

To edit a read-only copy of a document,

1  Choose Open as Copy from the File menu.

2  Type the name of the file you want to open in the Filename box, then choose OK or...
Choose File Manager, select the file you want to open in the file list,  then choose Open
as Copy.  Press F10 to display the “ Open as Copy” choice in File Manager in place of
“ Open into New Document”.

Brackets appear around the filename to indicate that you cannot save it under the same
name.

3  Edit the document, then save it under a new name.

PASSWORD WP 6.0b

An Enhanced Password Protection feature has been added.  This new level of password
protection includes case sensitive passwords.  It is important to note that files saved with an
Enhanced Password can be read by WordPerfect for DOS 6.0a and later but NOT earlier
WordPerfect 6.0 versions for DOS and Windows.  Also enhanced password protection is NOT
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useable with WP 6.2 if the program has been updated with the WP 6.2 updater file available
from the WPDOS web site.

PERSONAL IDENTIFICATION NUMBER (PIN) WP 6.0c

You can now save your customer support PIN so that it is readily available on the WP Info
screen when you call for customer support.  You will receive your PIN the first time you call
Customer Support.  See WP Info (Help).

PRINT WP 6.0a

Control Printer now displays the progress of the imaging graphics figure box, sending graphics
bitmap data, and sending page data. 

HP-GL/2 Vector Printing has been added.  All HP LaserJet IIIp, 4 and most later LaserJet
printers will print faster when printing lines and fills.  See Edit Printer Setup.

Edit Printer Setup: Shift+ F7, Select, Edit

Purpose: Use Edit Printer Setup to change the settings in your printer definition.

Steps:

1  Choose Print/Fax from the File menu, then choose Select.

2  Highlight the name of the printer you want to change, then choose Edit.

3  Choose “ Use HP-GL/2 Vector Graphics” to allow the printer to print vector format
images that do not  contain gradient fills using HP-GL/2 mode.   This option is only
available for many new  HP printers.

4  Choose OK.

5  Highlight the name of the printer you just modified, then choose Select to make it your
current printer.

PRINTER SUPPORT WP 6.1
 
WordPerfect 6.1 prints faster on many of the most popular printers, such as the Hewlett
Packard DeskJet 550C.  It also supports the Hewlett Packard DeskJet 660C and 850C printers. 
The WPDOS web site has drivers to support a great many later printers, both Inkjet and Laser,
including color laser printers and Postscript level 3 printers.  These drivers work with all
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versions of WordPerfect 6.x for DOS.

PRINTING WP 6.0b

A dialog now displays after the Print button is pressed and before you are returned to the
document screen.  The dialog first displays the message "Formatting Document"  and the page
number being formatted.  Then, while WordPerfect is writing the temporary print file to disk,
the message "Creating Print Information" and the page number displays. These messages
appear instead of "Please Wait.. . .".

If your printer can' t duplex, by selecting Print as Booklet and setting Odd/Even Pages to odd,
WordPerfect will print the front side of the booklet pages in one job.  You can then reinsert the
pages into the printer and choose to print the even pages as a booklet. WordPerfect will print
the reverse side of the booklet pages on the opposite side of the page.  See Print as Booklet
and Odd/Even Pages.

QUICKCORRECT WP 6.1

QuickCorrect uses a list of words to correct common errors as you type.  You can easily edit
the QuickCorrect list,  adding the words you misspell most often.  You can also add simple
abbreviations for the long words or phrases that you use often and then insert the
entire phrase into your document simply by typing the abbreviation. See QuickCorrect in
online Help.

QuickCorrect: Alt+ F1, QuickCorrect

Purpose: You can have QuickCorrect correct misspelled words and typos as you type. 
QuickCorrect can also insert matched open and close quotes (called
SmartQuotes), and assure correct capitalization and spacing.

Steps:

1  Choose Writing Tools from the Tools menu, then choose QuickCorrect.

2  Choose from the following options:

OPTION FUNCTION

Capitalize First Letter Capitalizes the first letter of each sentence and the first
letter of any word preceded by four or more spaces.
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Correct Two Irregular
Capitals

When two initial capitals appear in one word, lowercase
the second letter (for example, change TWo to Two).

Double Space to Single
Space

Eliminate any double spacing between the words in a
sentence.

Single Space to Two Spaces Converts a single space at the end of a sentence to double
spaces.

Two Spaces to Single Space Converts two spaces at the end of a sentence to a single
space.

Turn on Single Quotes

Insert opening and closing
single quotes around phrases
and uses a single quote when
one appears alone (such as in
the word I’ m).

Turn on Double Quotes Inserts opening and closing double quotes around phrases.

Use Regular Quotes With
Numbers

Uses straight quotes with numbers, rather than using
single or double closing quotes.

Replace Words As You Type Check this box to have Quick Correct use a list of words
to correct errors as you type.

3  Choose OK.

Special quotes are available for the Single and Double Quotes text boxes.  To insert a
quote: 

1  Place the cursor in a quote box.

2  Press List Quotes (F5), highlight the quote you want to insert, then choose Select or.. .
Press Ctrl+ w to display the Corel WordPerfect Characters dialog box, then select a
character.

QUICKFINDER WP 6.0b
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You can now specify a file pattern (for example, *.DOC) when searching an index.
  
QuickFinder now finds words in documents that use a character map other than WordPerfect
default.

QuickFinder will now find characters in the Greek, Hebrew, and Cyrillic character sets.

QuickFinder is an extensive and large system with documentation too extensive to cover in a
limited size document such as this is intended to be.  A list of all major subheadings under
QuickFinder in the WP 6.2 Help system follows.

QuickFinder

Add or Edit QuickFinder Index Directory Pattern
Clear
Create or Edit Index Definition
Directories and Files to Index
Generate Marked Indexes
Operators
QuickFinder File Indexer
QuickFinder Index Options
QuickFinder Search
QuickFinder Search Setup
Redo
Rename QuickFinder Index
Update Index

QUICKFORMAT WP 6.1

Use QuickFormat to copy fonts, attributes, and paragraph styles from one block of text to
another.  For example, if you have a terrific heading, you can use QuickFormat to make the
other headings in your document look the same.  QuickFormat links text together.  Changing
one changes all the others.  This lets you bold or unbold all your headings by pressing one
keystroke.  See QuickFormat.

QuickFormat: Shift+ F8, QuickFormat

Purpose: Once you have made some text in your document look just the way you want it
to, you are ready to use QuickFormat.  

You can use QuickFormat to "paint" a look you take from your document to other text
in your document.
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Steps:

1  Format some text in your document to look just the way you want it to.

You can now use QuickFormat to "paint" that look on other text.

2  Place the cursor in the text that has the format you want to copy or...   Block the text.

3  Choose QuickFormat from the Layout menu or...  Click the right mouse button, then
use the left mouse button to choose QuickFormat.

The QuickFormat dialog box appears.  In your document, the text that will become the
QuickFormat style is blocked so that you know exactly where the QuickFormat style
comes from.  In Graphics Mode, a box displays how the text will look.

The first time you create a QuickFormat style you give it a name, called a style name.

4  Choose OK to return to the document.

If you are in Graphics Mode, the cursor turns into a paint brush or paint roller to tell
you that you can now "paint" the look on other text.

In both graphics and text mode, a message tells you how to apply the QuickFormat
style to other text.  

5  Apply the QuickFormat style to other text.

You can use Reveal Codes to see the codes for where the QuickFormat style begins and
ends.

6  Continue applying the QuickFormat style.

To turn off QuickFormat,

7  Press Escape or...  Choose QuickFormat from the Layout menu or...  Click the right
mouse button, then use the left mouse button to choose QuickFormat.

All the QuickFormat styles by that name are linked together.  You can change their
appearance by changing just one.

QUICKMENUS WP 6.1

Handy context sensitive QuickMenus let you easily do the things you do most often.  For
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example, you can use QuickMenus to cut, copy, or delete blocked text.  See QuickMenus.

QuickMenus

Purpose: Handy, context-sensitive QuickMenus let you easily do the things you do most
often.  For example, you can use QuickMenus to cut, copy, or delete blocked
text.

The location of the cursor determines which QuickMenu will display.  You can
display QuickMenus in margins, text, tables, graphics boxes, and graphics lines. 
You can also use QuickMenus in headers, footers, and endnotes and with the
Ruler.

Steps:

To use a QuickMenu,

1  Place the cursor where you want to use the menu.

2  Click once on the right mouse button to display the QuickMenu.

3  Use the left mouse button to select the option you want or.. .  Click outside of the
QuickMenu to cancel it without selecting an option.

RETRIEVE WP 6.0b

All history lists,  (drop down lists of last used files) now allow up to 10 filenames.  The prior
limit was 4.  The lists are located in the Open/Retrieve, Sort (Source and Destination),
Play/Record Macro, and Merge dialog boxes so far as I have been able to determine.  This
enhancement is not documented in Help so far as I could find.

REVEAL CODES WP 6.2

Formatting codes can now be edited in reveal codes (press Ctrl-E).

You can now double-click a code (or press Ctrl-E) in Reveal Codes to edit the format setting
or content of the code.  For example, double-clicking a [Ln Spacing] code displays the Line
Format dialog box.  Double-clicking a header or footer code lets you edit the contents of the
header or footer.  See Reveal Codes.

RULER WP 6.0b

A Ruler comparable to the ruler in WordPerfect 6.0 for Windows has been added.  It allows
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for manipulation of table, column, and document margins, adjusting table columns widths, and
setting multiple types of tabs.  Ruler is enabled/disabled from the Layout drop down menu.

SAVE WP 6.0a

After retrieving an ASCII file, the default when saving is no longer ASCII.  Only the
AUTOEXEC.BAT and CONFIG.SYS files will default to ASCII during a save.  Saving other
imported ASCII files will activate a pop-up box when first saving, giving a choice of save
format.  If you wish to save a created file as ASCII use Save As rather than Save and choose
the ASCII format in the dialog box.

SEARCH AND REPLACE WP 6.0a

The Search and Replace Codes lists now have an Add button that allows you to insert a code
into the search/replace string without exiting the codes list.   See Codes or Commands.

SELECT PRINTER WP 6.0b

An Install/Printer Disk option has been added to the Add Printer dialog (Shift+ F7, s, a) to
allow adding a printer from within WordPerfect, instead of having to exit and run Install
externally.

SET FILE CONVERSION WP 6.0a

WordPerfect 6.0 now converts 5.1 *.SET files, if a 6.0 *.SET file is not found.  If a 5.1
*.SET file is not found, a new *.SET file will be created.

SHOW GRAPHICS WP 6.0c

You can now control when graphic images and equations are displayed in Graphics or Page
Mode.  Turning off graphics display can significantly increase editing speed when a document
contains a large number of images.  See Screen Options (Screen Setup).

SOFTSOLUTIONS INTEGRATION WP 6.0c

SoftSolutions, a document management system featuring network management, document
security enforcement, document version control, personal worklists,  audit trail tracking, and
automatic document archival and deletion is now more tightly integrated with WordPerfect.
(SoftSolutions is sold separately by Novell, Inc.) When WordPerfect is run from SoftSolutions,
WordPerfect opens and saves files differently so that when a document is opened or saved,
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control is passed to SoftSolutions which either catalogues or searches for
the document.  See SoftSolutions - Open/Retrieve Document or SoftSolutions - Save
Document.

SORT WP 6.0a

You can now turn Allow Undo off for Sort.   See Sort. 

Sort: Ctrl+ F9, Sort,  OK

Purpose: Use Sort to arrange text alphabetically or numerically,  or to extract specific
information from a list.   You can sort lines, paragraphs, tables, parallel
columns, or a merge data file.

Steps:

1  To sort a document, choose Sort from the Tools menu or...  To sort a table or parallel
column, place the cursor inside the table or parallel column, then choose Sort from the
Tools menu.

If you don' t want to sort everything in the entire document, block the text you want to
sort.

2  Specify the source and destination of the sorted text, or choose OK.

If you have blocked text, you don' t need to specify source and destination files.

3  Choose from the following options:

Edit Sort Key
Record Type
Sort Keys (Sort Priority)
Select Records
Sort Uppercase First
Sort Lowercase First (default)
Ignore Case (WP 6.2 only)

To increase the speed of sorting, deselect “ Allow Undo”.  Selected, this option stores
the necessary information to undo sort results.  If Allow Undo is off in Environment or
if the source destination is to a filename, you can' t select Allow Undo.

4  Choose Perform Action.
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If your text did not sort the way you want it to, choose Undo from the Edit menu unless
Undo was disabled.

SORTING WP 6.2

Ability to perform a case insensitive sort (as in WPDOS 5.0).  This option is not covered in
the online help but is available as an option in the sort criteria “ Case” selection drop down list
where you also can choose “ Lowecase First” or “ Uppercase First”.  See “ Sort” above.

SOUND WP 6.0b

Support has been added for the Sound Blaster 16ASP sound card on the Additional Drivers
disk.  The driver files are TAPISB16.COM and SB16.ARS.

SPELLER WP 6.0b

Many new words and abbreviations have been added to the WPUS.LEX file. New
WPUS.LEX, WPCC60US.DTL, and WPHY60US.DTL files have been added to improve the
speed of the Speller.  Throughout WordPerfect’ s history this has been an ongoing effort so I
expect that every release of WordPerfect, with or without version number change, has had
updated dictionary files.

SYSTEM VARIABLES FOR PAGES PRINTED WP 6.0c

Two new system variables, PagesPrintedLastJob and PagesPrintedThisSession, are now
available in the macro language.  These variables report the number of pages printed in the last
print job and since WordPerfect was started, respectively. You can insert these variables into a
macro using the Macro Commands dialog.

TABLES WP 6.0a

Reformat All Numbers has been added to the Columns/Tables dialog box.  See Reformat All
Numbers.

When Formula Recognition at Document Level is active, spaces, hard returns, tabs, or indents
will not be deleted when converting the cell' s contents to a formula.  See Formula
Recognition at Document Level.

Quick Table Lines (Graphics) has been added to speed up the display of tables.  See Window
Options (Screen Setup).

In table edit mode, Ctrl-B (Bold), Ctrl-U (Underline), Ctrl-I (Italics), and Ctrl-N (Normal) will
now toggle the cell attribute.
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TABLES WP 6.0b

AutoFill has been added to the Table Edit dialog box.  This feature recognizes a pattern of
incrementing values from two table cells and automatically completes the pattern across a row
or down a column.  The pattern can include Arabic or Roman Numerals, days of the week,
months, quarters, or table formulas.  For example, a users only needs to type January and
February in the first two cells of a table, block the table to be filled, and select the AutoFill
feature.  AutoFill will fill the rest of the cells with the remaining months of the year.

(NOTE:  The name of the current table or floating cell will be displayed on the status line (for
example, Cell A1 now reads Table_A.A1).

TABLES WP 6.1

You can now edit tables when you are in the document window without going into a special
table editing mode.  A new Tables pull-down menu is available from the main menu.  Also,
many new features have been added to make it convenient to edit tables as you create your
document.  Several bugs in these Tables functions are corrected in the original Novell release
of WP 6.1 by an update patch file available from the Corel FTP site.  This update patching file
should be applied to copies of WP 6.1 with the WP.EXE and WP.FIL files dated 8 August
1995 with a file time of 6:10a.  The updater changes the time to 6:10p.  See Tables.

TEMPLATES WP 6.1

Several ready-made documents called templates are provided for you.  These templates take
full advantage of WordPerfect features to add flair to your documents.  They make full use of
impressive letterheads, drawings and lines, and various font styles and sizes.  You can use
them to create a variety of documents, such as calendars, newsletters, and resumes.  Templates
are like blank, automated forms you can use to create your own documents.

Template: <   Shift+ F10, F4

Purpose: Templates make it easy for you to produce professional documents that take full
advantage of Corel WordPerfect' s many features.  Several ready-made templates
are provided for you.

Steps to use a template:

1  Choose Template from the File menu.

 You can choose to list either personal or shared templates.

2  In the Templates list box, highlight the template you want to use.
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3  Choose Select.

If you haven' t yet created a personal information set, a dialog box asks you for the
personal information that template needs.

4  Type the correct information in each text box, then choose OK.

A dialog box then asks you for the specialized information that template needs.

5  Type the correct information in each text box, then choose OK.

Corel WordPerfect creates the new document for you and displays it.   You can then
edit, print,  and save it.

See Also: 
Personal Information
Open Template
Template, Create
Template, Edit
Template Files

         
VIDEO DRIVERS WP 6.0b

Support for the Trident graphics card has been added.  The driver includes six graphics modes:
1024x768, 800x600, 640x480 (all in 16 and 256 colors); and seven text modes: 132x25,
132x30, 132x43, 132x60, 80x30, 80x43, 80x60 (all in 16 colors).

VIDEO DRIVERS WP 6.0b

Support for S3 chipset video cards has been added.  The graphics driver (S3.VRS) supports
640x480, 800x600, 1024x768 and 1280x1024 all with 16 and 256 colors.

WINDOWS ENHANCEMENTS WP 6.2

Improved stability and memory management under Windows is provided.

WPFI (WORDPERFECT FONT INSTALLER) WP 6.0b

The ability to delete graphic fonts from the WP.DRS file and printer fonts from the .PRS file
has been added.

Install/Delete Fonts (Font Setup):
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<   Ctrl+ F8, Shift+ F1, Install/Delete Fonts
<   Shift+ F7, Select, Edit,  Font Setup, Install/Delete Fonts

Purpose: Use Install/Delete Fonts to install specific third-party printer and graphics fonts
to use with Corel WordPerfect.  You can also use this option to remove fonts
that you have installed.

Steps:

1  Choose Font from the Font menu, choose Setup, then Install/Delete Fonts.

2  Choose a font type.

3  Choose another font type or.. .  Choose Exit.

For more information on installing fonts, choose Help from the Select Font Type screen or
from any screens that appear after you choose a font type.

CLOSING REMARKS

This compendium provides a list of all the various features you will NOT find in the regular
WordPerfect 6.0 manual, or in commercial WP 6 for DOS books.  Many are covered, albeit
briefly, in the WP 6.1 upgrade manual, if you have a copy of it.   They should also be covered
in the WP 6.2 Folio Infobase manual files included with WP 6.2 on CD and all changes prior
to WP 6.2 are covered in the Folio Infobase WP 6.1 Update manual included on Novell WP
6.1 CDs.  I have never seen a WP DOS 6.1 or 6.2 commercial book, or such an item listed on
ebay, and suspect that by the time WP 6.1 for DOS was released the publishers were no longer
interested in publishing DOS software books.  They were convinced that Windows was the
winner and that would be where the most sales and money were.

Use the “ Help” file and the “ Coaches” in Wordperfect to investigate further any of the above
items that look useful but are not covered fully enough here or in the documentation for your
particular version of WordPerfect 6.x.  This file also will hopefully provide a single source of
information on whether or not it is worth looking for a upgrade for the version you are
currently using, or what version to look for if you are looking for certain features.

Note that the references to exactly where to look in the Help file (the see xxxxx listings) are
for the version of WordPerfect listed for the introduction of the feature.  The reference title
may have been renamed or rephrased in later versions of WP 6.x and is sometimes not in the
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primary Help index but at a lower level in the Help tree.  Bolded items after a “ See” refer to
that title in the WordPerfect Help function.  In cases where the instructions for use are
included here there may be additional information available in Help under subheadings not
shown as available in this document.

For those who are interested, this file was assembled from several sources.  The upgrades and
changes information for WP 6.0b and WP 6.2 primarily came from information on the
WPDOS web site.  The information on changes and enhancements for WP 6.0a and WP 6.0c
came from my copy of Novell WP DOS 6.0c’ s “ What’ s New” section of the HELP screens. 
The WP 6.1 information came from the same source in my copy of WP DOS 6.1 from Corel. 
The “ how to” step by step information is from captured and reformatted help screens.  The
help screens information was captured by installing the “ ASCII Text Printer” as the default
printer and then setting up to “ print to file” with a default path and file name listed to be
printed to.  The result is that when the “ Shift F7" key combination is used within help files, to
print the given section of help information, it is sent to an ASCII file rather than to the printer. 
The ASCII file can then be imported into the final file and reformatted, saving a lot of typing. 
Additional information, based on personal use, has been added to extend and hopefully clarify
many of the entries.

Thanks are due to Ed Mendelson for creating and maintaining the WPDOS web site for all of
the WordPerfect for DOS fanatics out there in the computer world.
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